LAPORAN PELAKSANAAN
KEGIATAN PENGABDIAN PADA MASYARAKAT

“PELATITHAN CARA MEMPUBLIKASIKAN
FLASH MOVIE”

DALAM KEGIATAN PELATIHAN PEMBUATAN MEDIA PEMBELAJARAN
MENGGUNAKAN TEKNOLOGI INFORMASI PADA PONDOK PESANTREN “AL
BURHAN” GEDAWANG SEMARANG

OLEH:
PUJIONO, S.SI., M.KOM

BERDASARKAN SURAT TUGAS NO: 85/A.38.04/UDN.09/V/2011

FAKULTAS ILMU KOMPUTER
UNIVERSITAS DIAN NUSWANTORO SEMARANG
2011



KATA PENGANTAR

Puji syukur kami panjatkan ke hadirat Tuhan Yang Maha Esa, atas segala nikmat dan
karunia-Nya sehingga kami dapat menyelesaikan laporan pelaksanaan pengabdian
masyarakat “PELATIHAN CARA MEMPUBLIKASIKAN FLASH MOVIE ” dalam
kegiatan DALAM KEGIATAN PELATIHAN PEMBUATAN MEDIA PEMBELAJARAN
MENGGUNAKAN TEKNOLOGI INFORMASI PADA PONDOK PESANTREN. “AL
BURHAN" GEDAWANG SEMARANG yang diselenggarakan pada tanggal 13-14 Mei
2011. Kegiatan ini merupakan salah satu kegiatan program ipteks bagi masyarakat yng
diadakan sebagai suatu usaha untuk memberikan pelatihan tentang bagaimana cara-cara
mempublikasikan Flash Movie dalam mendukung pembuatan media pembelajaran
menggunakan teknologi informasi.

Dengan mengikuti kegiatan ini, Dua puluh satu (21) orang ustadz Pondok Pesantren Al
Burhan Gedawang Semarang diharapkan mempunyai tambahan pengetahuan dan
ketrampilan dalam membuat media pembelajaran menggunakan Teknologi Informasi
khususnya cara mempublikasikan Flash Movie yang diajarkan dalam pembuatan media
pembelajaran ini.

Dalam kegiatan ini jumlah peserta adalah 21 orang ustadz. Dalam laporan ini kami sajikan
pula materi pelatihan sebagai gambaran pelaksanaan kegiatan tersebut. |
Tiada gading yang tak retak, kami menyadari pada laporan ini masih banyak kekurangan,
karena itu tidak lupa kami menyampaikan maaf sebesar-besarnya.

Semarang, 2 Juni 2011
Pujiono, S.Si.,, M.Kom.
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A. Analisis Situasi
A.1 Kondisi mitra

Yayasan Al Burhan Semarang yang berdiri pada tahun 1991, berada
dibawah Pesantren Hidayatullah. Lembaga ini didirikan oleh beberapa anak
muda (mahasiswa) dari berbagai perguruan tinggi di Semarang pada saat itu,
yang punya idealisme dan komitmen tinggi dalam Islam. Dalam
perkembangannya Yayasan ini memiliki program utama: Sosial, Dakwah dan
Pendidikan.

Bidang sosial memberikan pelayanan, Penyantunan dan beasiswa
bagi anak-anak yang kurang mampu dan berpestasi. Bidang dakwah,
memberikan pelayanan pembinaan kepada masyarakat, instansi, desa binaan,
melaui pengajian- pengajian, kutbah jum’at, bimbingan belajar, bimbingan
keluarga dll. Bidang Pendidikan, memberikan pelayanan kepada masyarakat
luas terutama pada anak usia belajar melalui pendidikan formal.

Dari ketiga bidang utama tadi yang menjadi program unggulan
Yayasan adalah bidang pendidikan, mengingat pendidikan sangat peting bagi
anak- anak, sebagai genarasi penerus. Krisis multi demensi yang menyangkut
Agidah, ibadah dan moral berkembang pesat ditengah-tengah kehidupan
masyarakat. Padahal setiap orang tua pasti menghendaki anaknya tumbuh sehat
( baik jasmani maupun rohani).

Oleh karena itu melihat kenyataan yang demikian itu, maka pada
tahun 1999, Pondok Pesantren Al-Burhan Hidayatullah mulai merintis
Pendidikan formal Madrasah Aliyah (MA) untuk pa/ pi dan pada tahun 2004
mendirikan Madrasah Tsanawiyah (MTs) untuk pa. Lembaga pendidikan yang
dikelola adalah Lembaga Pendidikan Islam integral, berpesantren yang berbasis
Tauhid, dengan memadukan kurikulum Kepe.santrenan, Depag dan Diknas.

A.2 Dampak Keberadaan Mitra
Keberadaan Pondek Pesantern Al-Burhan Hidayatullah tentunya disambut baik

oleh masyarakat, sampai saat ini Pondok Pesantren Al-Burhan Hidayatullah
memiliki ratusan santri yang berada dibawah asuhan Pondok Pesantren Al-



burhan Hidayatullah. Adapun perkembangan dari tahun ke tahun dapat dilihat
dari tabel berikut,

Tabel 1. Perkembangan Data Santri Pondok Pesantren Al-Burhan Hidayatullah

No | Tahun | Kelas | Kelas Kelas | Kelas | Kelas Kelas
VII VIII IX X XI X1
1 |2004 29 26 24 29 26 24
2 | 2005 28 29 26 28 29 26
3 [2006 26 28 29 26 28 29 |
4 |2007 27 26 28 27 26 28
5 (2008 24 27 26 24 27 26 |
6 | 2009 51 23 28 51 23 28
7 12010 34 37 23 34 37 23
Jumlah 219 196 184 219 196 184
Santri-santri Pondok Pesantren Hidayatullah yang ada dipersiapkan untuk dapat
mencbar dakwah di wilayah sekitar Pondok Pesantren. Beberapa dari santriwan
dan santriwati ditugaskan untuk mengajar baca dan tulis Al-Qur’an di TPA
wilayah sekitar Pondok Pesantren. Para santri yang telah lulus bahkan ada
beberapa yang dijadikan sebagai guru di beberapa PAUD di wilayah Semarang
Selatan.
B. Permasalahan Mitra

B.1 Identifikasi Permasalahan Mitra

Dalam melakukannya kegiatannya Pondok Pesantren Al-Burhan Hidayatullah
Semarang dibantu oleh 21 ustadz dan ustadzah untuk membimbing para santri dan
dibantu oleh beberapa tenaga pasca. Tenaga pasca adalah santriwan dan santriwati
yang tclah menyelesaikan studinya di Madrasah Aliyah Pondok Pesantren Al-
Burhan Hidayatullah Semarang dan sedang dalam ikatan dengan Yayasan.
Adapun daftar pembimbing yang berada di Pondok Pesantren Al-Burhan

Hidayatullah dapat dilihat pada table berikut :
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Tabel 2. Data Pembimbing Pondok Al-Burhan Hidayatullah

e Status
Guru/Pegawai e
pa . v Pendi Tugas .
Nama - - | PNS/G No NUPTK
% - | % TM | dikan | Mengajar i
il 2l : TT/GT i
e YTy -
1 | Agustina Ekayati GTY | 2006 | MA | Bhs. Arab 6151761665300003
2 | Ahmad Haris GTY | 1999 | MA | Sosiologi 1538751661200002
Ahmad Taufan, Bhs.
3 ) L GTY | 2004 S.1
S.Fil.1 Indonesia 4657756653200022
Dodi Setiawan, '
o L GTY | 2004 S.1 | Bhs. Inggris
S.Pd.I 7344757657200003
Nahwu -
5 | Hari Sutarto, Lc L GTY | 1999 S.1
Shorof 8846746649200052
Akidah
6 | Masrukin, S.Ag L GTY | 1999 S.1 2353753654200010
Akhlak
Memy Ritahati, .
i g < P P GTY | 2003 S.1 Bhs. Inggris | 8248745647300053
ochamad Isnadi
8 o . j GTY | 1999 S.1 Matematika | 3539745647110050
BC.,, S.Si
Moh. Anggi
9 ¥ GTY | 2009 5.1 Eko - Akun
Samukroni, S.Pd :
10 PR A GTY | 2005 S.1 Matematika | 7142758660110073
Mustofa, S.Pt
Mutmainah Qur'an
11 ) GTY | 2003 51 .
Rahmawati, S.Ag Hadits 7450751652300032




.

12 | Nasirin, S.Pd.] L GTY |[2005| S.1 |SKI 5440756659200003
13 | Paryadi GTY | 2004 | STM | TIK
Pasidin Khoirudin,
14 L GTY | 1999 | S.1 |Fiqih
S.Ag 2635747649200062
15 | Rismiati, S.E P GTY | 2008 | S.1 |Eko-Akun |2063757659210063
Siti Chotimah,
16 p GTY | 2003 | S.1 | Geografi
SPd.I 0846754655300052
Tahfidzul
17 | Suharno L. GTY |2006 | MA
Hadits 41 57763665200033
18 | Supriyono, S.Ag L GTY | 2001 S.1 | Bhs. Arab | 2139750652200073
19 | Ulil Albab, A.Ma L GTY |2004| D.2 |Sejarah 0559760662200033
20 | Zainal Arifin, S.S L GTY |2006 | S.1 |Bhs. Inggris | 1945751652110032
21 | Muji, AMd P PTY [2000| D.3 1434757656200003

Perkembangan teknologi informasi memaksa para pembimbing untuk selalu
belajar mengikuti perkembangannya. Pembuatan media pembelajaran yang
menarik menjadi salah satu fokus untuk mengembangan kegiatan belajar
mengajar di Pondok Pesantren Al-Burhan Hidayatullah Al-Burhan Semarang.

Kendala lain yang dialami oleh pihak Pondok Pesantren Al-Burhan
Hidayatullah adalah tidak adanya pengajar yang mumpuni yang dapat
mengajarkan para pembimbing untuk membuat media pembelajaran yang
menarik untuk para santri. Selama ini belum ada pihak luar yang memberikan

pelatihan-pelatihan untuk pembuatan media pembelajaran.

B.2 Prioritas Penanganan

Mengingat minimnya perangkat komputer yang ada di Pondok Pesantren Al-
Burhan Hidayatullah Semarang, maka program (I,M) IPTEKS bagi Masyarakat
nantinya akan berfokus pada pelatihan pembuatan media pembelajaran untuk
para ustadz dan ustadzah yang berada di lingkungan Pondok Pesantren Al-
Burhan Hidayatullah Semarang.
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C. Solusi yang Ditawarkan

Bentuk solusi yang ditawarkan adalah dengan memberikan pelatihan pembuatan
media pembelajaran dengan menggunakan tools Macro Media Flash.

D.Target Luaran
Jenis luaran dari progam pengabdian ini adalah jasa pelatihan pembuatan media
pembelajaran. Diharapkan masing-masing ustadz dan ustadzah dapat membuat

media pembelajaran yang sesuai dengan bidang ilmunya masing-masing.

E. Manfaat Program
Program IzM yang kami usulkan tentunya akan bermanfaat bukan hanya
bagi pelaksana saja namun manfaat yang didapat bersifat simbiosis muiti-
mutualisme' karena memiliki kompleksitas faedah yang beragam.
j Manfaat bagi Instansi Perguruan Tinggi (UDINUS) :

® Menjadi sarana promosi secara tidak langsung. Karena dalam setiap
publikasi yang dihasilkan selalu membawa nama instansi kampus.

e Menambah daftar portofolio pengabdian pada masyarakat yang berarti juga
akan menambah point bagi akreditasi kampus.

e Pemberdayaan Dosen pada program pengabdian pada masyarakat akan
berdampak pada semakin baiknya mutu pengajaran, yang berarti akan
menambah baik pula mutu keluaran/alumi Udinus

2. Manfaat Bagi Tim pelaksana/dosen :

e Menambah indeks prestasi pengajar atau KUM bagi dosen yang terlibat
pada program pengabdian pada masyarakat

o Penyaluran ilmu dan intelektualitas dosen kepada guru.

3 Manfaat bagi Pondok Pesantren Al-Burhan Hidayatullah Semarang :

¢ Mendapatkan pendampingan dan pelatihan pembuatan media

pembelajaran dengan menggunakan macro media flash.

e Menjalin relasi yang baik dengan instansi perguruan tinggi (UDINUS)

! sebuah hubungan yang terjalin secara fungsional atau pihak satu sama lain saling menguntungkan



F. WAKTU PELAKSANAAN

Pelaksanaan kegiatan pengabdian kepada masyarakat yang berupa pelatihan
pembuatan media pembelajaran menggunakan teknologi Informasi pada pondok

pesantren Al Burhan Gedawang Semarang, telah di laksanakan pada :

Hari

. Jum’at — Sabtu

Tanggal : 13 — 14 Mei 2011
Tempat : Pondok Pesantren Al Burhan, Gedawang Semarang

JADWAL PELAKSANAAN

Hari /Jam

Tempat

Materi

Instruktur

Jum’at 13 Mei 2011

08.00 - 09.00

Lab
Pondok Pesantren
Al Burhan

Komputer

Gedawang

Semarang

Registrasi
Pembukaan
pelatihan

dan

Tim Pengabdian

09.00-09.30

Lab
Pondok Pesantren
Al Burhan

Gedawang

Komputer

Semarang

Pre Test

Tim

09.30-11.30

Lab  Komputer
Pondok Pesantren
Al Burhan
Gedawang

Semarang

Interface
Macromedia
Flash

Sugiyanto,M Kom |

11.30-13.00

Ishoma ‘

13.00 - 14.30

Lab
Pondok Pesantren
Al Burhan
Gedawang

Komputer

Semarang

Menjalankan
Macromedia

Flash

Etika
Kartikadarma,M.Kom
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14.30 - 16.30

Lab  Komputer
Pondok Pesantren
Al Burhan
Gedawang
Semarang

Bekerja  dengan
Layer

Macromedia

Sari
Wijayanti M. Kom

Sabtu, 14 Mei 2011

07.30 -09.30

Lab  Komputer
Pondok Pesantren
Al Burhan
Gedawang

Semarang

Animasi

Annas Marzuki, S.Sn
Ifan Rizqa,M.Kom

09.30-11.30

Lab  Komputer
Pondok Pesantren
Al Burhan
Gedawang

Semarang

Movie Clip

Nova
Rijati,S.Si,M.Kom

11.30-12. 30

Ishoma

12.30-14.30

Lab  Komputer
Pondok Pesantren
Al Burhan
Gedawang
Semarang

Button and
Action Script

Harisudin Hakim

Yunita Kemalasari

1430 -16.30

Lab  Komputer
Pondok Pesantren
Al Burhan
Gedawang

Semarang

Publikasi

Pujiono S.Si,M.Kom
Budi
Widjajanto M. Kom




G. PESERTA

Peserta pengabdian diikuti 21 (dua puluh satu ) ustadz pondok pesantren al

. Burhan Gedawang Semarang.
Adapun daftar nama peserta pelatihan adalah sebagai berikut :
NO NAMA ASAL SEKOLAH

1 | M.Isnadi Budi Cahyono MA.Al Burhan
2 | Pariyadi MTS Al Burhan
3 | Ulil Albab MTS Al Burhan
4 | Dodi Setiawan MA Al Burhan
5 | Toyipur SD Islam Diponegoro
6 | M.Mustofa MA.AI Burhan
7 | Hari Sutarto MA Al Burhan
8 | Supriyono MTS.Al Burhan
9 | Nasirin MTS.Al Burhan
10 | Pasidin Khoirudin MA_ Al Burhan
11 | Zaenal Arifin MA. Al Burhan

! 12 | Siti Chotimah MA Al Burhan

. 13 | A-Hari’i MA.Al Burhan

. 14 | Galih Pratama MA Al Burhan
15 | A.Taufan MA . Al Burhan
16 | Suharno MA Al Burhan
17 | Musrikun MA. Al Buthan
18 | Agustina Fka Yanti MA_Al Rurhan
19 | Nur Fadhilah MA.Al Burhan
20 | Na’imatul Mufidah MA Al Burhan
21 | Sulis Tiyani MA:Al Burhan

H. METODE YANG DI GUNAKAN

1. Persiapan

- Persiapan yang dilakukan meliputi koordinasi pemilihan instruktur dan
narasumber yang berkompeten di bidangnya, pencarian referensi dan




penyusunan modul pengajaran dan pelatihan yang disesuaikan dengan
kemampuan dan kualitas peserta pelatihan, _

Adapun instruktur dan narasumber pada kegiatan ini adalah dosen di
Fakultas Imu Komputer Universitas Dian Nuswantoro Semarang yang
memiliki kompetensi sesuai  bidangnya, berpengalaman  dalam
mengembangkan ilmunya di laboratorium masing-masing, berpengalaman
dalam menerapkan metode pembelajaran yang didukung pemanfaatan
ICT. Instruktur dan Narasumber juga mempersiapkan modul pelatihan dan
maten pembelajaran serta pengkayaannya.

. Pelaksanaan

Proses pembelajaran pada kegiatan ini dilaksanakan dalam bentuk

partisipasi aktif peserta dengan metode student centered learning m:lalui

eksplorasi atas materi pengkayaan, penugasan, praktikum, diskusi dan
pendampingan oleh narasumber dengan memanfatkan sofiware dan
perangkat multimedia.

* Pra tes, bertujuan untuk mengetahui kemampuan peserta pelatihan
dalam memahami materi yang akan diajarkan.

* Penyampaian materi pengkayaan dengan menggunakan metode
pembelajaran berpusat pada siswa (student centered learning) melalui
penugasan dan pendampingan dengan memanfatkan software dan
perangkat multimedia.

* Monitoring dan evaluasi proses pembelajaran yang mencakup evaluasi

selama kegiatan dan evaluasi akhir kegiatan

Untuk menjamin mutu pelaksanaan program pengkayaan sesuai dengan

tujuan yang ditetapkan, perlu dilaksanakan langkah - langkah berikut :

1. Pemilihan instruktur yang mempunyai kompetensi di bidang
multimedia dan materi pengkayaan.

2. Pemanfaatan modul pelatihan, penugasan dan praktikum yang jelas,
terarah dan berbobot.
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3. Pemantauvan dan evaluasi perkembangan peserta berkesinambungan
selama pelaksanaan kegiatan,

3. Evaluasi dan Pelaporan
Evaluasi dilakukan pada hari Sabtu , 14 Mei 2011 setelah sebelumya
dilakukan monitoring dengan tujuan untuk bisa megetahui kekurangan
yang ada pada pelaksanaan kegiatan sebelumnya sehingga diharapkan ada
perbaikan untuk kegiatan berikutnya.
Sedangkan laporan kegiatan ini meliputi: tahap persiapan, pemilihan
sasaran, materi kegiatan, detail pelaksanaan kegiatan, dan hasil kegiatan.

I. KESIMPULAN

Dari pelaksanaan kegiatan Pengabdian pada Masyarakat ini, dapat disimpulkan

beberapa hal sebagai berikut :

1. Para Guru Pondok Pesantren Al Burhan menyambut positif materi-materi
yang diberikan dalam pelatihan pembuatan media pembelajaran
menggunakan teknologi Informasi pada pondok pesantren Al Burhan
Gedawang Semarang dan memandang perlunya kerja sama yang lebih erat
pada kegiatan-kegiatan yang lain berikutnya..

2. Secara umum kegitan pengabdian dapat dikatakan berhasil, meskipun ada
kendala keterbatasan waktu, karena banyak aktivitas mereka yang sulit
ditinggalkan .

3. Dialog, pertanyaan, opini, maupun pendapat dari peserta dapat menjadikan
pemacu bagi Fakultas Ilmu Komputer Universitas Dian Nuswantoro untuk

lebih berkembang dan memberikan sumbangsih bagi masyarakat luas.



LAMPIRAN DAFTAR PESERTA



DAFTAR HADIR PESERTA PELATIHAN PEMBUATAN MEDIA PEMBELAJARAN
Materi Ke: I. Intertace Macromesra :’alqg‘l.,_

e

NO NAMA ASAL SEKOLAH __ TTD
1 [M.Isnadi Budi Cahyono  |MA.Al Burhan 1 M
2 |Pariyadi MTS Al Burhan L 2
3 |Ulil Albab MTS Al Burhan W -
4 |Dodi Setiawan MA Al Burhan 4 Yt
5 |Toyipur SD Islam Diponegoro 5 \r/\. g
6 [MMustofa MA Al Burhan e =
7 |Hari Sutarto MA_ Al Burhan 7 ﬁe\_ / ;
8 |Supriyono MTS.Al Burhan / ) 8 /;#:1/
9 |Nasirin MTS.Al Burhan o =
10 [Pasidin Khoirudin MA Al Burhan * 109
11 |Zaenal Arifin MA.Al Burhan 15 2e =
12 |Siti Chotimah MA.Al Burhan n g
1
13 |A Harig MA.Al Burhan 137 _+
3
14 |Galih Pratama MA Al Burhan 1
4o
15 |A.Taufan MA . Al Burhan 15 ,
A7 ,
16 |Suharno MA Al Burhan 16 Lo/
I
17 [Musrikun MA.Al Burhan 17 Ay )
18.|Agustina Eka Yanti MA . Al Burhan 18
S .
19 |Nur Fadhilah MA.Al Burhan 19 g
)
20 |Na’imatul Mufidah MA Al Burhan 20287
21 |Sulis Tiyani MA.Al Burhan 21 (L\
T
,f‘/“:;um_.
sEMARANG | /'b“f\/"“ S
l ﬁtl]Ml)R 0 Py S S /T’ ,}‘.\@"g\
PENGESAHAN [l "Ai‘
TELAH DIVCKIKSA KFBENAFANNY L bz ™ [xy
AN SESUAL DERGAN ASLINYA W\ > e
P \ A B —_‘1\. — %Q.
|‘._____”__ \':E“-L?,E.EP\



DAFTAR HADIR PESERTA PELATIHAN PEMBUATAN MEDIA PEMBELAJARAN

Materi Ke: T . MEuéaLawk&u MacromeN A 4Lasy

NO NAMA ASAL SEKOLAH 4 TID
1 [M.Isnadi Budi Cahyono |[MA.Al Burhan 1
2 |Pariyadi MTS Al Burhan z R /ﬁ‘%\q\
3 |Ulil Albab MTS Al Buthan 3 /Z;Q
4 |Dodi Setiawan MA Al Burhan 4 Lﬂ}j
5 |Toyipur SD Islam Diponegoro 5 C'}\,_)\ /
6 [MMustofa MA Al Burhan ;6
7 |Hari Sutarto MA.Al Burhan 7 Y v
8 |Supriyono MTS.Al Burhan l / 8 ' =i
9 [Nasirin MTS. Al Burhan LN
10 |Pasidin Khoirudin MA Al Burhan 10
11 |Zaenal Arifin MA.Al Burhan 0 2=
12 |Siti Chotimah MA Al Burhan " 12
13 (A Haris MA.Al Burhan TR ! '
14 |Galih Pratama MA Al Burhan L wf
15 |A Taufan MA Al Burhan 15 /G - .
16 |Suharno MA.Al Burhan 16 ']:o«/ f
17 |Musrikun MA. Al Burhan 17 chl-é} ,
18. |Agustina Eka Yanti MA Al Burhan " sod
19 [Nur Fadhilah MA Al Burhan 19 - 1
20 |Na’imatul Mufidah MA_ Al Burhan . 20
21 |Sulis Tiyani MA Al Burhan |21 ‘/-i Y
| R\
vﬁtqksn iAN ;Ig’;/#m%%n
JPELAR OIERIKSA (6 MARANNY A S ,Lf,%}}
= Mﬂngg?um DENGAN ASLINYA o /i
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DAFTAR HADIR PESERTA PELATIHAN PEMBUATAN MEDIA PEMBELAJARAN

Materi Ke:E- gekER?(')“a DEGAY LA\]{EQ\ MATCROMEDTA .

NO NAMA ASAL SEKOLAH ~y  TID
1 [M.Isnadi Budi Cahyono  [MA.Al Burhan 1

2 [|Pariyadi MTS Al Burhan /", 2 ]
3 [Util Albab MTS Al Burhan 3 %
4 |Dodi Setiawan MA. Al Burhan

5 |Toyipur SD Islam Diponegoro 5 db"

6 |M.Mustofa MA. Al Burhan

7 |Hari Sutarto MA Al Burhan 7

8 |Supriyono MTS.Al Burhan

9 |Nasirin MTS.Al Burhan “

10 [Pasidin Khoirudin MA.Al Burhan £

11 |Zaenal Arifin MA.Al Burhan 11

12 |Siti Chotimah MA.Al Burhan

13 |AHari§ " MA.Al Burhan 13

14 |Galih Pratama MA Al Burhan

15 |A.Taufan MA Al Burhan 15

16 [Suharno MA. Al Burhan

17 |Musrikun MA Al Burhan 17

18 |Agustina Eka Yanti MA Al Burhan

19 [Nur Fadhilah MA.Al Burhan 13

20 |Na’imatul Mufidah MA.AI Burhan

21 |Sulis Tiyani MA. Al Burhan 21

SEMARDNG |

NOMOR e

r AR iy I

PFNGESAAAN
TELAH BI%: < L XEL NARANNYS
© -DANSESUA) DENGAN ASLINYA




DAFTAR HADIR PESERTA PELATIHAN PEMBUATAN MEDIA PEMBELAJARAN

s Materi Ke:1V. AOTMAST
) NO NAMA ASAL SEKOLAH 4 TID
1 |M.Isnadi Budi Cahyono |MA.Al Burhan 1
2 |Pariyadi MTS Al Burhan J e zﬂ%
3 |Ulil Albab MTS Al Burhan 3
4 |Dodi Setiawan MA.Al Burhan 4 7‘,_?,
5 |Toyipur SD Islam Diponegoro 5 (? :/
6 [MMustofa MA.Al Burhan R o
7 |Hari Sutarto MA.Al Burhan =M I/
8 [Supriyono MTS.Al Burhan / VaEs .
9 |Nasirin MTS. Al Burhan Y
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BAB 1
INTERFACE MACROMEDIA FLASH 8

1. Pengenalan Macromedia Flash
Macromedia Flash merupakan standar profesional yang digunakan untuk
membuat web lebih hidup dengan permainan animasi dan sinkronisasi suara yang
mengagumkan. Bayangkan pada halaman web, anda dapat membuat animasi atau
promosi suatu produk seperti iklan di layar televisi. Merancang menu navigasi seperti
menu navigasi pada game interaktif agar pengunjung tidak merasa bosan berada
dalam situs anda.
2. Konsep Dasar Dan Istilah
a. Flash Stage.
Flash Stage dalam kenyataan seperti layar bioskop. Pada flash stage berupa
kotak putih besar. Semua obyek seperti gambar, tulisan, dan foto ditempat pada
stage. Di luar area kotak putih, tersebut merupakan daerah berwarna abu-abu. Di
area ini penonton tidak dapat melihat objek apapun saat film sedang dimainkan.
Perhatikan gambar dibawah. layar Flash dibawah ini :

£ Mocromedia [ sl Professionsl 0 = [Untitled-1] 3 3
Fla E® View st Modfy Tewt Commends Conrdl Window Help gl
& ===
L3 | Timeine 1 Seornn 1 = & Em P Sl v
o] 1"} s ~ s - = = » - - s - ™ w el "
T il @ @ (=] S
g a RO v n
0 7 5 @ 02w .1
e v
0 o8 loano B b ou®l o1 ek s < > Mpha 100% v | FODSSCC
> =
L g
B ©a SR
s £ 7 Library - Untttded-1 [ 3
O oA Unitttec | v % A
. & Bty dorary
x L2-1 2
Ortions
e [Typs &
o
e > }
B g 5 SSERSSTl
B Properies  PRwer | Farameters STAGE ;;
I? Coaument Sroi [ mouacOphel | Mackomundi | Frama riben 12 fps i
Unitind-{ Py [ settings.. | Py 8 AcionSoresi 2 profter Defas
owace: [ semngs. ] s
. ailed < L

Ukuran default dari stage adalah 550 picxel dan tinggi 400 picxel (picture
elment).Picxel merupakan titik terkecil pada layar monitor Anda. Untuk
mengubah ukuran sesuai kebutuhan : Klik menu Modify = Document, muncul
dialog box Document Properties seperti pada gambar di bawah, Anda tinggal
mengubah sesuai kebutuhannya.
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b. Toolbox
Toolbox berisi alat kerja berupa berbagai simbol gambar atau icon yang
masing-masing mempunyai fungsi tertentu dan paling sering digunakan. Adapun
komponen-komponen toolbox adalah sebagai berikut :

- Subselect
ubselec
Arrow R K
Free Transform =1 5 4 Gradient Transform
Line - 2 Lasso
Pen 6 A - Teks
Oval O O - Rectangle
Pencil P > Brush
Ink bottle e} ‘& - Paint Bucket
Dropper R P - Eraser
Wiesnr
Hand oM Q, - Zoom
Colors
Stroke Color Z
Fill Color T ———— ‘s -.
Defaultcolor — o) 1 Swap Color
Option ﬂ ; \ No Color
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1) Arrow, digunakan untuk memilih objek. Dengan 1 kali klik berarti sebuah
objek telah dipilih, dengan klik ganda (dua kali) berarti Anda memilih objek
dan seluruh komponen yang dimilikinya. Dengan mendrag Arrow tool Anda
dapat membuat sebuah area persegi yang akan mengaktifkan pemilihan atas
semua yang ada di dalamnya.

2) Line, merupakan alat untuk membuat garis. Bila A1 da membuat garis sambiil
menekan tombol Shift, maka akan terbentuk garis yang horisontal, vertikal
atau miring 45o.

3) Pen, digunakan untuk membuat objek elips (oval). Untuk membuat lingkaran
gunakan tool ini sambil menekan Shift.

4) Pencil, Adalah alat untuk menggambar garis atau titik secara bebas.

5) Free Transform, digunakan untuk memodifikasi bentuk dari suatu objek.

6) Ink Bottle, digunakan untuk mewarnai suatu garis. _

7) Eyedropper, digunakan untuk mengambil warna yang berasal dari suatu objek
di stagge sehingga Anda bisa menyamakan warna ketika menggambar,

8) Hand, digunakan untuk menggeser stage secara bebas, sanggat berguna bila
Anda memperbesar (zoom) stage schinga tidak seluruh stage terlihat dilayar.

9) Stroke Color, digunakan untuk memiliih warna ketika mengambar garis.

10) Fill Color, digunakan untuk mengisi warna dari bagian dalam objek yang
sedang digambar. Disini juga tersedia efek pengisian tergradasi.

11) Default Color, Klik ikon ini untuk men gembalikan stroke color menjadi hitam
dan fill coor menjadi putih.

12) No Color, digunakan untuk menghilangkan warna dari garis atau warna dari isi
objek tergantung penggunaannya.

13) Option Pane, menampilkan berbagai pilihan untuk memodifikasi efek dari
suatu tool yang kita pilih, berbeda untuk setiap tool.

14) Subselect, digunakan untuk memodifikasi suatu ggaris yang dibuat dengan Pen
tool.

15) Lasso, digunakan untuk memilih suatu area secara tidak teratur. Semua yang
masuk areanya akan terpilih.

16) Text, digunakan untuk membuat text box yang dapat diisi dengan berbagai
tulisan.

17) Rectangle, digunakan untuk membuat bentuk persegi. Bila ingin membuat
bujur sangkar secara sempurna gunakan tool ini sambil menekan tombol shift

18) Brush, digunakan untuk menggambar dengan kuas secara bebas.

19) Fill Transform, digunakan untuk memodifikasi bentuk dan posisi dari
Gradient Fill.

20) Paint Bucket, digunakan untuk memodifikasi warna dan gradasi warna di
dalam suatu objek.

21) Eraser, digunakan untuk menghapus suatu gambar.

22) Zoom, merupakan kaca pembesar untuk memperbesar gambar, tetapi juga
dapat berfungsi sebaliknya, yaitu untuk memperkecil gambar.

23) Swap Color, digunakan untuk membalik warna garis atau isi suatu objek.
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¢. Layer Area

Layer adalah lapisan yang menutup permukaan stage. Stage biasanya terdiri
dari beberapa lapisan (layer) dimana dengan ini setiap objek dapat bergerak
sendirisendiri berdasarkan layer-masing-masing. Layer seperti lembaran kertas
tranparan yang berguna untuk membantu proses animasi dan penggambaran.
Layer tidak hanya untuk objek gambar saja, tetapi dapat berupa suara dan tulisan.

Timeline | £ Scene 1
" ®a83 Show All Layer
- E As Outline
- v & Folder 1 Lievany
yer Names &) Laver 1 { { O
Insert Layer
—hiJ — Delete Layer
. Lock / Unlock All Layers
Add Motion Guide
Show / Hide All Layers

Insert Layer Folde

Komponen-komponen layer adalah sebagai berikut -

1) Layer Name, menunjukkan nama dari setiap layer yang ada pada proyek.
Untuk mengubah nama layer, klik ganda sebuah layer name, dan namailah
setiap layer sesuai isi atau tujuannya bagi proyek tersebut,

2) Add a Layer, digunakan untuk menambahkan suatu layer dalam proyek.

3) Add a Motion Guide Layer, digunakan untuk menambah layer panduan yang
disebut Guide Layer. Layer ini berisi sebuah jalur yang digunakan untuk
memandu arah gerak sebuah objek. Jalur ini tidak akan nampak ketika movie
dijalankan.

4) Delete Layer, Bila ditekan akan menghapus sebuah layer yang dipilih beserta
semua objek yang terdapat didalamnya. Hati-hati menggunakannya,

5) Show or Hide Layer, digunakan untuk menampakan layer yang sedang
disembunyikan dan sebaliknya.

6) Lock or Unlock Layer, digunakan untuk mengunci atau membuka layer.

7) Show Layer as Outlines, menyebabkan semua objek yang terdapat pada suatu
layer akan ditampilkan dalam bentuk kerangka luarnya saja.

. Timeline

Timeline adalah elemen yang dimiliki Flash untuk mengontrol semua
kejadian ketika movie dimainkan. Jadi, semua jalan cerita diatur disini, kapan
aktor ini harus muncul dan kapan menghilang atau kapan efek suatu harus ada dan
sebagainya. Sehingga Timeline mempunyai tugas mengatur waktu cerita dan
pemunculan objek-objek tertentu.
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Komponen utama Timeline adalah :

Playhead, dengan melakukan drag terhadap Playhead menuju frame-frame
yang berlainan, Anda akan dapat melihat isi dari setiap frame, vang Anda
tuju. Bila Anda mengklik sebuah frame, maka secara otomatis Playhead akan
bergerak menuju frame yang Anda pilih.

Frame Number, merupakan pemandu Anda dalam bekerja dengan timeline.
Center Frame, digunakan untuk membantu menampilkan frame yang sedang
bekerja ke tengah-tengah daerah timeline yang terlihat, sangat berguna bila
Anda membuat movie dalam frame yang panjang mengingat timeline yang
terlalu panjang tidak akan ditampilkan seluruhnya dalam jendela.

Onion Skin View, merupakan fasilitas untuk menampilkan beberapa frame
sebelum dan atau sesudah frame yang kita pilih sekaligus. Frame-frame selain
frame yang kita pilih akan ditampilkan dalam nuansa yang lebih lembut dari
aslinya (bayang-bayang). Ini adalah fasilitas yang bagus untuk
memperhatikan urutan langkah animasi yang kita buat.

Onion Skin Outline View, mempunyai fungsi yang sama dengan Onion Skin
View, hanya saja gamabaran onjek yang ditampilkan pada tiap frame hanya
berupa kulit terluar dari objek itu.

Edit Mulitiple Frames, membantu Anda untuk memodifikasi beberapa frame
sekaligus.

Modify Onion Markers, menampilkan menu yang dapat dipilih untuk
menentukan seberapa banyak frame yang akan ditampilkan dalam mode
Onion Skin View.

Current Frame, menampilkan nomor frame yang sedang dipilih.

Frame Rate, menunjukkan berapa frame per detik yang akan ditampilkan
dalam Flash Movie Anda.

10) Playback Time, menunjukkan sudah berapa detik sebuah frame dijalankan.
11) Seroll Bars, melihat frame-frame yang tidak sanggup ditampilkan oleh

timeline yang tampak.

S|Flash 8



BAB 2
MENJALANKAN MACROMEDIA FLASH

Untuk menjalankan Macromedia Flash 8 dapat melalui Start Menu dengan cara :
Klik Menu Start - Programs - Macromedia -> Macromedia Flash 8,

selanjutnya akan ditampilkan layar utama Window Flash seperti yang ada pada gambar di
atas.

1.Menggambar Dan Mewarnai

Sebelum memulai menggambar perlu diketahui dulu alatnya. Flash
memberikan bermacam-macam alat (tool) untuk menggambar berbagai macam
bentuk seperti garis, lingkaran dan kotak. Dalam flash tools merupakan kumpulan
simbols gambar atau icon yang mempunyai fungsi tertentu dalam proses
penggambaran seperti gambar 1.3. di atas.

Fungsi-fungsi yang dapat dilakukan oleh tool tersebut disesuaikan dengan
gambar icon yang ada seperti untuk membuat garis berarti gunakan Line tool,
atau membuat lingkaran berarti gunakan Oval tool, dan sebagainya.

2.Membuat Tulisan
Jika anda membuat tulisan di Flash, kita dapat mengubah ukuran, warna,
spasi dan perataannya, mirip seperti halnya kita sedang mengetik naskah pada
Word. Anda juga dapat memperlakukan tulisan sebagai objek yang dapati diputar,
diperbesar, atau diperkecil dan dimiringkan.

3. Mengenal Property Inspector Untuk Teks
Modifikasi atas properti teks dapat dilakukan sebelum atau setelah teks
tersebut selesai dibuat. Hal ini dapat dilakukan dengan berbagai cara, tetapi yang
termudah adalah dengan menggunakan Property Inspector yang muncul setelah

ikon Text tool dipilih.
4% Properties Fiters | Parameters &
SatxTer v | A TmesNewRomen viocvBEBIESEEqQN @
Text Tool ?a‘y 0 v A% Normal v Anti-alias for readabidity v
: il | [ auto ke
L] Target: i
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Di dalam Property Inspector tersebut terdapat ikon-ikon yang berfungsi
untuk mengatur properti yang dimiliki oleh teks, yang dijalankan hanya dengan
menekan tombol kiri mouse pada ikon perintah yang dibutuhkan Setelah itu akan
terjadi perubahan sesuai yang diinginkan.

Menulis Dengan Text Tool
Untuk membuat tulisan gunakan Text Tool :
1) Pilih menu File > New untuk memulai pekerjaan baru.

2) Klik text tool A .

3) Kursor berubah menjadi tanda “+” saat kita arahkan ke stage. Kemudian klik
pada stage dan kotak tulisan akan muncul.

4) Saat kita mengetik, flash otomatis memperlebar kotak tulisan tersebut sesuai
dengan panjang tulisan. '

5) Block handle hanya dapat ditarik ke kiri dan ke kanan untuk mengatur ukuran
kotak tempat tulisan kita,

PITATHIAN
MACROMEDIA 11 ASIHN Block handle
UNTUK GURU-GURT! SN

MENGEDIT DAN MENYELEKSI TULISAN
Pilih salah satu cara di bawah ini untuk masuk ke mode edit :
1) Klik dua kali tulisan di stage dengan Arrow tool, atau
2) Kilik satu kali tulisan di stage dengan Text tool.
Setelah tulisan di stage masuk dalam mode edit yang berupa kotak dengan

block handle, Anda dapat menyeleksi dengan cara menyoroti tulisan dengan
mouse.

TRANSFORMING TEXT

Tulisan di Flash dianggap sebagai objek yang dapat diputar, diperbesar dan
diperkecil atau dimiringkan tetapi tetap kita dapat mengetik tulisan tersebut untuk
mengeditnya.
Untuk mentranform tulisan
1) KIik tulisan yang ada di stage,

2) Contoh bila ingin memutar tulisan, klik toolbar Free Tranform = . Akan
muncul titik-titik transform Yyang dapat diputar.
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3) Klik Rotate and Skew Modifier, Klik dan drag salah satu handle di sudut
kotak untuk memutar teks.

4) Lepaskan pointer di garis kotak teks (diantara kotak pegangan) dan kemudian
drag untuk memiringkan teks.

5) Drag salah satu handle di salah satu sudut kotak teks untuk memperbesar atau
memperkecil ukuran teks.

PELATIHAN
MACROMEBIA FLASI 8
UNTUK GURU-GURU SMP

6) Untuk memperendah atau mempertinggi teks drag salah satu kotak pegangan
di bawah atau di atas kotak teks.

7) Untuk memanjangkan atau memperpendek teks, drag salah satu kotak
pegangan disamping kotak teks.

8) Anda dapat menggabungkan berbagai efek untuk memodifikasi teks Anda.

. MEMECAH TEKS MENJADI BAGIAN-BAGIAN TERSENDIRI

Untuk memecah teks, menjadi bagian-bagian tersendiri dapat dilakukan
dengan berbagai cara :

1) Klik Arrow tool pada toolbox. Pilih blok teks yang akan dipecah. Setelah
blok teks terpilih, klik Modify Break Apart untuk memecah huruf-huruf ke
dalam blok teks tersendiri. Blok teks akan diletakkan pada posisi yang sama
dengan posisi asalnya.

2) Pilih kembali Modify Break Apart untuk menjadikan setiap huruf sebagai
artwork yang dapat dimodifikasi.

3) Untuk memodifikasi setiap huruf yang ada dapat dilakukan dengan Arrow
tool atau Free Transform tool.

Dengan menggabungkan teknik-teknik modifikasi teks, Anda akan dapat
menemukan efek yang sangat bagus.
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BAB 3
BEKERJA DENGAN LAYER

1. Menambahkan Layer Baru

Setiap kali kita membuka dokumen baru Flash, maka otomatis akan
terbentuk sebuah layer yang diberi nama Layer 1. Bila Anda menambuhkan

sebuah layer lagi, maka layer tersebut akan diberi nama Layer 2 dan diletakkan di
atas layer pertama. Demikian seterusnya.

Membuat Layer Baru

Jumlah layer yang dapat dibuat tidak terbatas bergantung pada besar memori
komputer. Layer tidak menambah ukuran file. Untuk menambah layer lakukan :

1) Klik simbol “Insert Layer” 7

2) Atau juga bisa memilih menu Insert > Layer.

3) Setelah menambah layer, maka layer baru akan muncul tepat di atas layer
yang sekarang sedang aktif.

Informasi Layer
Berikut ini informasi dari tampilan layer pada timeline :

1. Icon “mata”l | untuk menampilkan dan menyembunyikan semua objek
yang ada di stage pada layer tersebut.

2. Icon “kunci” & untuk membuka dan mengunci objek yang ada di stage
pada layer tersebut agar tidak dapat diedit secara sengaja maupun tidak
sengaja.

3. Icon “kotak” O untuk menampilkan objek di stage dalam gambaran secara
online, bukan dalam keadaan gambar yang sebenarnya. Ini berguna bila obyek
tersebut sangat besar sehingga memberatkan kerja komputer.

Mengedit Layer

Mengubah urutan layer :

1) Klik nama layer untuk mengaktifkan layer.

2) Seret nama layer tersebut ke posisi urutan yang diinginkan.

Mengubah nama layer :
1) Klik dua kali nama layer, kemudian ketik nama layer yang diinginkan.

Duplikasi layer :
1) Klik nama layer yang ingin diduplikasi.
2) Pilih menu Edit > Copy Frames.

3) Buat layer baru dengan mengklik simbol “Insert Layer” '9.
4) Klik nama layer yang baru tersebut kemudian pilih menu Edit > Paste
Frames.
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5. MENGUBAH URUTAN LAYER
Urutan layer dapat diubah dengan cara sebagai berikut :
1) Klik Layer yang ingin dipindah.
2) Drag layer ke urutan yang diinginkan, baik ke atas atay ke bawah.

=80

[ Layer 3 « « [J
[ Layer 2 (' e B
Q_!.qyerl o « [
7+ E] i |

10|Flash 8



s

BAB 4
ANIMASI

Pada pembahasan kali ini kita akan mempelajari teknik-teknik animasi seperti

mengubah ukuran objek, memutar, mengubah warna, fade in-out, dan efek morphing,

1.

Keyframe

Keyframe adalah sebuah frame yang telah didefinisikan sebelumnya dan
merupakan frame kunci yang menentukan perubahan pada animasi. Jika anda
membuat frameby-

Jrame animation, sctiap frame adalah keyframe yang kita buat sendiri
secara manual. Pada tweened animation, keyframe merupakan salah satu frame
penting sehingga pembuatan animasi dapat dilakukan otomatis oleh Flash.

Menciptakan Keyframe
Untuk menciptakan keyframe pada suatu frame di timeline, lakukan salah
satu dari hal berikut :
1) Pilih sebuah frame pada timeline kemudian pilih Insert > Keyframe.
2) Letakkan kursor pada sebuah frame di timeline kemudian klik kanan dan pilih
Insert Keyframe.

MENGATUR FRAME RATE
Frame Rate adalah kecepatan suatu animasi dimainkan dalam frame per
detik (fps). Standar kecepatan suatu film adalah 24 fps, sedangkan pada aplikasi
web seperti Quick Time dan AVI movies pada umumnya mempunyai kecepatan
12 fps. Biasanya kecepatan 12 fps ini akan memberikan hasil terbaik di web.
Untuk mengubah frame rate lakukan : Klik menu Modify © Document,
dan ubahlah nilai fps pada tag frame rate.

Document Properties

Dimensions: Z20  (width) x 400px  (height)

Match: ¢ Prinker %) Defauk
Background color:
Frame rate: 12 fps
Ruler units:  Pixels v
[ J[ cna ]
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4. Membaca Timeline

Flash membedakan representasi tipe animasi dalam timeline sebagai berikut :

1) Motion tween diindikasikan sebagai sebuah lingkaran hitam pada keyframe
awal, dilanjutkan dengan anak panah menuju keyframe akhir dengan latar
belakang biru terang.

2) Shape tween diindikasikan sama seperti motion tween, tetapi berlatar
belakang hijau terang.

3) Garis putus-putus menandakan tween animasi belum lengkap, misalnya isi
dari keyframe akhir belum ditentukan.

4) Sebuah keyframe diindikasikan sebagai sebuah lingkaran hitam. Frame yang
berlatar belakang abu-abu lembut yang berada setelah sebuah keyframe
menunjukkan bahwa frame-frame ini mempunyai isi yang sama sampai
diakhiri dengan sebuah persegi kosong. '

5) Huruf a kecil mengindikasikan bahwa frame tersebut telah ditetapkan sebagai
¢ action dengan action panel

6) Sebuah bendera (flag) merah mengindikasikan bahwa frame tersebut
mengandung label atau komentar.

7) Jangkar (anchor) emas mengindikasikan frame tersebut sebagai named
anchor.

Ada dua cara teknik animasi di Flash, yaitu tweened animation (Motion
Tween dan Shape Tween) dan Frame-by-frame animation. Tweened
animation anda tinggal menentukan posisi frame awal dan akhir, kemudian {lash
akan mengerjakan animasi frame-frame sisanya yang berada di antara posisi awal
dan akhir tersebut. Frame-by-frame animation membuat gambar yang berbeda di
setiap frame.

. Membuat Motion Tween

Prinsip kerja dari motion tween adalah benda dapat bergerak dari titik A ke
titik B. Kita tinggal mengisi frame pertama (tittk A) dan pada temnpat
pemberhentikan (titik B), selanjutnya flash sendiri yang secara otomatis akan
menangani frame-frame lainnya.

. Membuat Animasi Bentuk

Langkah-langkah untuk melakukan animasi bentuk adalah sbb:;

1) Klik Rectangle tool, lalu gambarlah bujur sangkar di bagian kiri layar.

2) Klik menu Edit =  Select All untuk memilih bujur sangkar.

3) Klik menu Insert > Convert to Symbol, akan muncul kotak dialognya,
pilihlah pada bagian Behavior : Graphic.

4) Klik pada frame 20 di timeline, kemudian klik menu Insert = Keyframe.

5) Posisi masih pada frame 20, klik Arrow tool, kemudian pilih bujur sangkar
dan pindahkan ke bagian kanan layar.

6) Klik pada frame 1 untuk kembali ke frame 1, kemudian lihat ke bawah layar
pada Properties. Pilihlah bagian Tween: pilih Motion.
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7) Klik menu Control & Test Movie untuk menjalankan animasi (Control
= Play/hasil test ada pada scene). Untuk meyimpan hasil latihan, klik
menu File >  Save As, kemudian beri nama filenya.

8) Untuk menghentikan test tekan Ctri+W.

Keterangan :

Langkah pertama adalah menggambar lingkaran dengan Rectangle tool.

Dengan perintah Select All, kita memilih semua bujur sangkar baik bidang

maupun pinggirnya karena ketika Anda menggambar, secara default Flash akan

memberi dua unsur objek yaitu bidang dan pinggimya.

Sebelum bisa dianimasikan, bujur sangkar harus diubah menjadi simbol dengan

perintah Convert to Symbol.

Symbol adalah objek Flash. Di dalam simbol inilah objek animasi dibuat. Ada

tiga jenis symbol.

1) Movie Clip, untuk membuat rangkaian animasi objek di dalamnya.

2) Button, untuk membuat tombol interaktif,

3) Graphic, untuk membuat animasi diam yang siap untuk dianimasikan pada
layar.

Objek yang diubah ke simbol ditandai dengan tanda plus di tengah objek. Apabila

suatu objek sudah dikonversi ke simbol, akan masuk ke dalam daftar Library.

Library adalah tempat penyimpanan objek-objek dalam Flash yang sudah

dikonversi ke simbol dan objek-objek yang diimpor dari tempat lain. Dengan

adanya Library, objek-objek dapat terorganisasi dengan baik.

Membuat Animasi Putar

Langkah-langkah :

1) Klik Oval tool, kemudian gambarlah bola dengan wama gradasi dan
pencahayaannya dari atas kiri.

2) Pilih bola yang sudah digradasi, kemudian klik menu Insert = New
Symbol pilih Graphic.

3) Klik pada frame 30, lalu klik mouse sebelah kanan pilih Keyframe.

4) Klik Arrow tool, kemudian pilih bola gradasi dan pindahkan ke bawah kanan
layar

5) Klik pada frame 1 untuk kembali ke frame 1, lalu pada Properties pilihlah
bagian Tween: Motion, isikan pada Ease: -100(in) dan Rotate:CW dengan
nilai 1 times.

6) Terakhir tambahkan suara. Klik menu Windows = Comman Libraries
=2 Sound, akan muncul pilihan suara.

7) Seret salah satu sound, misalnya Beam Scan ke objek bola gradasi di frame 1.
Jalankan animasi.

Keterangan :

Ba

Latihan ini masih menggunakan motion tween, tapi dengan sedikit modifikasi
pada bagian properties-nya untuk menghasilkan animasi berputar, seperti : Ease
ada dua jenis yaitu:
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1) Ease Out (100) berfungsi untuk membuat animasi dimulai dengan cepat dan
diakhiri dengan lambat.

2) Ease In (-100) berfungsi untuk membuat animasi dimulai dengan lambat dan
diakhiri dengan cepat.

* Rotate ada tiga jenis :

1) Auto, berfungsi untuk memutar objek sekali pada arah yang ditentukan oleh
motion.,

2) CW (Clockwise), berfungsi untuk memutar objek dengan arah sesuai dengan
jarum jam.

3) CCW (Counterclockwise), berfungsi untuk memutar objek dengan arah yang
berlawanan dengan jarum jam.

* Penggunaan suara menambah daya tarik animasi. Suara dapat diambil dalam
Flash dalam Comman Library Sound. Jika ingin mengambil suara dari koleksi
Anda sendiri, maka harus diimpor terlebih dahulu ke dalam library. Klik menu
File > Import, pilih file suara yang dimiliki. Jenis suara yang diperbolehkan
dalam Flash adalah : MP3, WAV, SUN AU, AIFF.

8. Membuat Animasi Warna

Langkah-langkah :

1) Klik Text tool, lalu tulislah kalimat ‘FLASH 8, melalui Properties aturlah
Jenis hurufnya Arial Black, ukuran 30, dan warnanya hitam,

2) Klik Arrow tool, Pilih teks, Klik menu Insert & Concert to Symbol, lalu
ubahlah menjadi simbol Graphic.

3) Klik pada frame 20 lalu masukkan Keyframe, lakukan hal yang sama pada
frame 40.

4) Klik frame 20 lagi untuk kembali ke frame 20, lalu pilih teks menggunakan
Arrow tool. Pada Properties, pilihlah pada bagian Color:Alpha dengan nilai
0%.

5) Klik pada frame 40, lalu pilih teks. Pada Properties, pilihlah pada bagian
Color: Tint dengan warna Hijau dan nilai 100%.

6) Klik pada frame 1, lalu pada Properties pilihlah bagian Tween:Motion.
Lakukan hal yang sama pada frame 20. Jalankan animasi.

Keterangan :

* Efek wamna Alpha pada suatu objek akan memberi efek mumudar, misal tulisan
FLASH 8, karena diberi efek alpha dengan nilai 0%, maka tulisan tersebut
perlahan-lahan akan menghilang.

* Efek Tint atau wamna tint pada suatu objek akan memberi efek perubahan warna,
misalnya tulisan FLASH 8, yang semula berwarna hitam akan berubah menjadi
hijau.

9. Membuat Shape Tween
Animasi shape tween digunakan untuk mengubah bentuk suatu objek
menjadi bentuk yang sama sekali lain dari aslinya. Misalnya jika kita ingin
mengubah bentuk dari huruf Z menjadi huruf A.
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10. Membuat Animasi Bentuk

11.

12.

Sebagai latihan kita akan membuat objek kotak menjadi teks kotak.

Langkah-langkah :

1) Klik Rectangle tool, dan buatlah sebuah kotak dilayar.

2) Klik pada frame 30, lalu klik menu Insert - Blank Keyframe.

3) Masih di frame 30, klik Teks tool, lalu tuliskan kalimat ‘KOTAK.

4) Pada tulisan, lalu klik menu Modify > Break Apart sebanyak dua kali.

5) Klik pada frame 1 untuk kembali ke frame 1, lalu pada properties pilihlah
bagian Tween : Shape. Jalankan animasi dan lihat hasilnya.

Frame-By-Frame Animation

Frame-by-frame animation ini seperti pekerjaan manual yang dilakukan oleh
manusia bila membuat film kartun dan penggunaan sangat cocok untuk animasi
yang rumit. Cara kerja Flash tidak berbeda seperti itu. Kita menggambar frame
per frame di stage, setelah itu baru dijalankan. Animasi jenis ini mempunyai
ukuran file jauh lebih besar dibandingkan tweened animation.

Membuat Frame-By-Frame Animation

Definiskan setiap frame sebagai keyframe dan ciptakan gambar yang
berbeda pada setiap frame. Bila kita menciptakan sebuah keyframe baru, maka isi
dari keyframe itu secara otomatis akan sama dengan keyframe yang
mendahuluinya sehingga selain bisa mengganti frame tadi dengan gambar yang
lain kita juga dapat memodifikasi gambar sebelumnya untuk membuat suatu
perubahan.

1) Klik sebuah layer untuk memilih layer tersebut dan kemudian klik sebuah
frame pada layer tersebut di mana anda ingin animasi di mulai.

2) Jika frame pertama tadi belum berupa keyframe, pilih menu Insert
- Keyframe pada menu bar untuk membuatnya.

3) Ciptakan gambar animasi anda. Anda bisa menggunakan Drawing Tool pada
toolbox atau mengimport sebuah file.

4) Klik frame berikutnya pada layer yang sama kemudian pilih Insert
< Keyframe.

5) Karena isi keyframe baru ini sama dengan isi keyframe sebelumnya, maka
anda dapat memodifikasi gambar itu atau menggantinya dengan gambar yang
baru.

6) Untuk menyelesaikan animasi anda, ulangi langkah 4 dan 5 sampai animasi
anda menjadi komplit.
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BAB 5
MOVIE CLIP

Movie Clip adalah sebuah symbol yang menampung animasi Flash atau disebut
juga sebagai mini movie. Movie Clip akan tersimpan di dalam jendela library sehingga
dapat dipergunakan berulang kali. Movie Clip dapat dijalankan di dalam movie utama
hanya dengan menggunakan satu buah frame.

Membuat Movie Clip
Berikut langkah membuat Movie Clip;

1. Siapkan lembar kerja default.

2. Selanjutnya kita akan membuat animasi putar pada objek bintang yang diletakkan
di dalam Movie Clip.

3. Klik menu Insert » pilih New Symbol atau tekan Ctrl + F8 sehingga akan
ditampilkan kotak dialog Create New Symbol seperti pada gambar di bawah:

Crentaﬂew__iyﬁlbp{_._ )

Ketikkan “ Bintang” pada kotak Name, untuk memberi nama Movie Clip.

Pilih Movie Clip pada pilihan Type.

Akhiri dengan OK sehingga secara otomatis, Anda akan aktif di dalam tampilan
lembar kerja Movie Clip “Bintang”.

O B

Movie clip “ Bintang “

Untitled-1* v - &%
e & EETTETIIRTA 6 6, e v
&30 5 10 5 0w X 3 ¥ B
RELAT AR ~
Wil B | oo @1 ok oo ¢ 5

7. Selanjutnya membuat animasi pada Movie Clip “Bintang”,
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8. Didalam layer 1, buat objek bintang pada frame 1 seperti pada gambar di bawah:

Untitled- 1%

- =
Timeline %5 Scene | & 100% -
- 80 5 10 1% 20 25 30 3s IR
BT T R n? N
v

&£ @ t oo ®™E L 2ekr Do < >

-~

<

~

9. Klik kanan pada frame 20, pilih Insert Keyframe.
10. Klik kanan diantara frame 1 sampai dengan 20, pilih Create Motion Tween,

11. Ubah pilihan Rotate dalam jendela properties menjadi CW. Pilihan CW
merupakan perputaran searah jarum jam,

r v Pr-opertles Fiters ! F_ar;muters

; IT Frame  Tween: Motion v [“Iscale
Fomiess 5 iboed i Ease: O v Edit... ]

Label type: . Rotate: Auto 4

(] orient to [Flsync  [“lsnap

Rotate CW

12. Animasi sudah dibuat, selanjutnya kembali ke lembar kerja movie utama. Untuk
kembali ke movie utama, perhatikan gambar dibawah:

Kembali ke Movie utama

rLI'ﬂbd-l’ 5k . -2%
ke | 0 IEEEGTTRET s 4w .
& &80: s 10 15 = 30 35 S
m e ' A
tip B
+74% 48] o f ao ™ 20 2o fps 165 < F
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13. Selanjutnya memasukkan symbol Movi
movie utama (layer 1 — frame 1).
14. Tekan F11 untuk menampilkan jendela library.

15. Geser Movie Clip “Bintang” dari jendela library ke dalam lembar kerja movie
utama. Perhatikan gambar di bawah:

e Clip “Bintang” dari library ke dalam

[,w,. s o L S 2 - &y Lt o
| Timelne 5 Scena 1

§ "
wao g | son

w
£ Y Herma o

16. Selanjutnya perhatikan tampilan timeline layer 1 pada movie utama seperti pada
gambar di bawah. Di dalam frame 1, berisi Movie Clip “Bintang”

iy
_ -8x
5_ --ﬁ'}v 1003}
- 5 10 15 20 F3 30 35 =,
-~
v
4GE) T )} so B 1 2ofs 00 ¢ b

17. Jalankan animasi dan perhatikan hasilnya. Animasi Bintang akan dijalankan
meskipun hanya menempati satu buah frame.
18. Simpan file Anda dengan nama Movie Clip.fla.
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BAB 6
BUTTON

Symbol Button dapat digunakan sebagai tombol navigasi dalam sebuah animasi

atau movie yang dihasilkan program Flash Pro 8. Di dalam sebuah symbol Button
terdapat empat bagian dengan penjelasan sebagai berjkut:
®

Up  :merupakan tampilan awal tombol Pada saat tidak disentuh oleh pointer
mouse

* Over :merupakan tampilan pada saat pointer mouse menyentuh atau berada di
atas simbol

¢ Down : merupakan tampilan pada saat tombo] di klik dengan mouse

* Hit :merupakan area klik pada tombol

Membuat Symbol Button
Semua objek yang dibuat di dalam Flash Pro 8 dapat digunakan sebagai symbol
Button. Berikut kita akan membuat symbol Button dari sebuah objek teks:
1. Siapkan lembar kerja baru dengan tampilan defaylt.
2. Klik menu Insert P> New Symbol sehingga tampil kotak dialog Create New
Symbol seperti pada gambar di bawah:

| ndvamed_J

Ketikkan “Tombol” untuk memberi hama s ymbol Button pada kotak Name.

Pilih Button pada pilihan Type dan diakhiri dengan OK

Secara otomatis, anda akan aktif didalam tampilan lembar kerja symbol Button
Tombol. Perhatikan tampilan timeline Sepex-ti pada gambar di bawah:

Ll

(i SE i -

Timelne ¢ S & R S & 0% i

* & 0| [EETowFow 1]

P s s B "
l_ﬁ”"a@ Bt sa® 1 peps e < »
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6. Dalam timeline terdapat empat frame yaitu Up, Over, Down dan Hit.

7. Klik pada frame Up dan buat objek teks “Tombol” dengan warna Hitam.

Perhatikan gambar di bawah:
Unttled-1* . -8%
e | & RTINS ¢ ) - .
v @ ) o B 1 ok 0 < >

Tombol

8. Selanjutnya membuat tampilan Over pada tombol.

9. Klik kanan frame Over P> pilih Insert Keyframe sehingga didalam frame Over
disisipkan keyframe dengan objek teks yang sama dengan frame Up.

10. Ubah warna teks pada frame over menjadi merah dan perbesar ukuran teks

sehingga pada saat pointer mouse berada diatas tombol, maka tombol akan
berubah warna merah dan berubah ukuran.

] B { oo B 2 20k o ¢ >

Tombo
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11. Klik kanan frame Down P> pilih Insert Keyframe.

12. Ubah ukuran teks “Tombol” seperti pada frame Up dengan posisi teks yang sama
sehingga pada saat tombol diklik akan mengecil.

4

Untitled-1*

_meine | G2 TN

& & 0| Tow i =

P et p
v

el @ ) oo® [ 3 2oks o ¢ >

Tombol

13. Untuk membuat frame Hit, klik kanan pada frame Hit P Insert Keyframe
sehingga isi dan frame Hit sama dengan frame Down. Frame Hit digunakan untuk
menentukan area klik pada tombol. Area klik pada tombol menyesuaikan dengan

bentuk dan ukuran tombol. Tampilan timeline tombol akan nampak seperti pada
gambar di bawah:

[ s

el @} oo @] 4 Rofs 0x < 5

14. Setelah sclesai membuat tombol, klik Scene 1 untuk kembali ke lembar kerja
movie utama.

15. Selanjutnya menyisikan symbol Button dari library ke dalam lembar kerja movie
utama.

16. Tekan F11 untuk menampilkan jendela Library. Klik nama symbol Button
“Tombol” dan geser ke dalam lembar kerja movie utama.

17. Jalankan animasi. Pada saat tombol ditunjuk, tombol berwarna hitam. Pada saat
pointer mouse berada diatas tombol, maka berubah menjadi warna merah dan
membesar, selanjutnya pada saat diklik maka tombol mengecil ke ukuran semula.
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18. Catatan : Anda dapat membuat symbol Grapic atau Movie Clip pada masing-
masing frame Button schingga tampilan tombol semakin menarik.

BAB 7
ACTION SCRIPT

Action Script adalah suatu perintah yang menghasilkan suatu aksi atau gerakan
pada objek. Perintah Action Script digunakan untuk membuat animasi yang lebih
kompleks dan interaktif,

Fungsi Panel Action Script
Panel Action Script digunakan untuk memberikan perintah action pada sebuah

frame, objek tombol atau Movie Clip instance.

Langkah untuk membuka jendela Action adalah dengan menekan tombol F9
atau klik menu Windows P Actions. Gambar di bawah adalah bagian-bagian dari
jendela Action:
porsorpii0820 V| RBOY @ N soptamn @
Global Functions 1]

(@) Global Properties

@ Operators

@ Statements

@ AclionScript 2.0 Classes
@ Compiler Directives
Constanis

Types :
@ Deprecated :F
Data Components

Components
@ Scresns

@ Index

il
B [A] Current Selection A

El Layer 1: Frame 1 : lE] Lmrl:ilvﬁﬁl

5 Scenet v Linelof1,Coll

Tombol perintah yang dapat digunakan dalam jendela Action 1 antara lain:
a. Add a New Item to the Script

Digunakan untuk memberi/menambah perintah Action Script %.
Contoh:

1. Klik frame atau objek vang akan di beri script.
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2. Klik tombol Add a New Item to the Script % P Global Function P
Timeline Control > Play

v

if ¥ Actions - Frame 25w "5
Msapionne v BB Qv E @ . Aspas O
E&Mmm Global Funchions Pl Timele Control g @ » ELETVES TR S
(3] @bl Propertis Gobal Praperties P rowserletwork  »| gotoAndStop Escegs
(@) opeators Operators P Printing Functions ’_f nextframe  Escif
) sttaments Statements b Misceloneous Functions | nedSeens  Escins
. ActionScript 2.0 Classes » Mathamatical Funciions b | e
ActionScript 2.0 Classes
%: i Diraciin Compler Directivas b, Conwersion Functions  #
@c - Constants b Movie Cip Control » 4
@T!Pﬂ Typas b
I MM ]
@M“d «#  Data Components b |
’ @M&upnum A ¢ ) ;
@Cw Sersens »
@Sum
@ 1ndex
AT |
B [A] Curent Selacton A
T vayer 1 Frame
B s v Rielofl,Cdl
b. Find

Digunakan untuk mencari dan mengganti kata atau karakter yang terdapat
pada perintah Action Script 2.

c. Insert a Target Path
Digunakan untuk menyisipkan target atau sasaran yang akan di beri perintah
Action Script.
Contoh penggunaan tombol Insert a target path ®
1. Buat gambar objek bola di layer dengan tombol Gval.
2. Klik Arrow Tool dan pilih gambar objek Bola tersebut.
3. Tekan tombol F8 untuk mengubah objek. Bola menjadi objek Button.

Convert to Symbol

Heme:  Bola

e Omﬂmp_ . mngﬂ
Regstr g2
®Batton -
O Graphic

4. Pada bagian Name, ketik Bola, pada Type, pilih Button kemudian tekan OK.
5. Klik bagian Instance Name, Kemudian beri nama Bola.

% Pproperties Fiters | Parameters

% ‘_E;tton _v"! Sadeped  Bile 23|Flash 8
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6. Tekan tombol F9 untuk menampilkan jendela Action.
7. Klik tombol Add a new Item to the Script » Global Function P Movie

Clip Control P On, maka tampil perintah script seperti nampak pada gambar
di bawah.

¥ Actions - Button 5
A OYE @2 N\ soptasse @

on @) ¢

) press ~
@ ralease A
@ releaseOutside
@ rolover
@ rofiout
@ dragOver
@ dragout
@ keyPress "<left>" -

Bela | p§

1of 3,ColS

8. Klik dua kali perintah Press sehingga terbentuk perintah script berikut

¥ Actions - Button

2P OVEREERY

En {presa) {
# )

9. Klik di belakang tanda kurung kurawal buka “{“ kemudian tekan tombol
Enter untuk memberi jarak baris.

10. Klik tombol Add a new Item to the Seript » Global Function P Movie
Clip Control B> StartDrag, schingga terbentuk perintah script berikut:

¥ Actions - Button

ROOVE R

on (press) {
atartDrag():

)

11. Klik tombol Insert a target path maka tampil kotak dialog insert Target Path
seperti gambar di bawah:
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12. Klik nama Instance Objek yaitu bola yang berada di dalam kotak dialog

Insert Target Path keriudian tekan tombo! OK, sehingga terbentuk perintah
script berikut-

¥ Actions - Button

|2 P OvRE®

1 on (press) {
startDrag(this):

3}

13. Klik dibelakang kurung kurawal yang bawah kemudian tekan Enter untuk
memberi jarak baris.

14. Klik tombol Plus P> Global Functions P Movie Clip Control P> On,

15. Klik dua kali perintah release, schingga terbentuk perintah script berikut:

¥ Actions - Button
2 POVERE

on (press) (
startDrag(this):

}
on (release) {
{ 5§
16. Klik di belakang kurung kurawal yang atas kemudian tekan Enter untuk
memberi jarak baris.
17. Klik tombol Plus P> Action P> Movie Clip Control P> stopDrag, agar objek
bola dapat digeser dan dilepaskan di posisi yang lain. Perintah script akan
terlihat seperti perintah berikut:

¥ Actions - Button
R P OVEERE

on (pressj {(
starcbrag(chis);

)

on (release) {
stopbrag():

)

18. Tekan tombol Ctrl + Enter untuk menguji perintah di atas.

. Check Syntax
Digunakan untuk memeriksa apakah perintah Action Script yang dituliskan
tersebut benar atau tidak v .
Contoh 1:
1) Tampilkan jendela Action dengan menekan F9.
2) Ketikkan perintah gotoAndPlay(1).
3) Tekan tombol Check Syntax, maka tampil komentar This script contains no
errors, berarti tidak ada kesalahan dalam penulisan script Anda.

X]

This script contains no errors
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Contoh 2:

1) Tampilkan jendela Action dengan menekan F9.

2) Ketikkan perintah gotoAnStop(.

3) Tekan tombol Check Syntax, sehingga tarnil komentar This script contains
errors, The errors encountered are listed in the Output Window, berarti
ada kesalahan dalam script Anda.

This script contains errors, The errors encountered are listed in the Ou*put Panel,

Auto Format
Digunakan untuk mengatur format pada perintah Script yang telah
dimasukkan, sesuai dengan format yang telah diatur oleh program Flash 2

Show Code Hint

Digunakan untuk menampilkan kode penunjuk & untuk membantu Anda
dalam menuliskan perintah yang benar.
Contoh:

Pada jendela Action, ketikkan rumus stop( maka tampil keterangan yang
menunjukkan bagaiman seharusnya rumus stop tersebut diketik.

o : . Rumus stop
stop (); " yang benar

Jika keterangan tersebut tidak muncul tekan tombol Show Code Hint untuk
memunculkannya.

Debug Options
Digunakan untuk menampilkan atau menghapus tanda breakpoint %. Klik
tombol Debug Options, maka muncul 3 perintah yaitu:
* Toggle Breakpoint, untuk menampilkan tanda breakpoint.
* Remove Breakpoint, untuk menghapus tanda breakpoint.
* RemoveAll Breakpoint, untuk menghapus semua tanda breakpoint

Seript Assist
Peranti ini digunakan untuk mengolah perintah script tertentu sehingga

mempermudah kita untuk mengatur parameter dari script tersebut \ Soit Assist

Qoto 1 GO to the speciied frame of the mavie

(3)Go to and play (Go to and stop

Scens: | <current scene>
Type: _Frams Number

F'ML "l‘ - — - - P— - - ——— —
2= P v \ st | @

on (releasse) | 26|FIaSh 8
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BAB 8
PUBLIKASI

Keistimewaan Flash yang dipublikasikan adalah dapat didesain untuk keperluan
presentasi pada sebuah animasi halaman Web. Perintah publish akan menyisipkan file
Flash Player (SWF) dan dokumen HTML ke dalam jende'a browser.

Perintah Export Movie mengijinkan Anda membuat isi Flash yang dapat
disunting dalam aplikasi yang lain dan mengekspor sebuah movie langsung kedalam
format tunggal. Sebagai contoh, Anda dapat mengekspor movie seperti file Flash Player,
rangkaian image bitmap, frame tunggal atau file image, dengan berbagai variasi format,
termasuk GIF, JPEG, PNG, BMP, PICT, QuickTime, dan Avi.

Mempublikasikan Flash Movie
Untuk mempublikasikan Flash Movie pada Web, Anda dapat menggunakan

dua langkah proses. Pertama, siapkan semua file yang diperlukan untuk melengkapi

aplikasi Flash dengan Publish Settings. Kemudizn konversikan file movie beserta

isinya dengan perintah Publish. Langkah dalam menentukan pilihan untuk file Flash

movie adalah:

1. Buat sebuah animasi sesuai dengan selera Anda dan simpan animasi tersebut
dengan nama: Design.fla pada folder Animasi.

2. Pilih menu File P Publish Settings, sehingga tampil kotak dialog Publish
Settings seperti pada gambar di bawah:

Current proffe: EETT SN - 5+ 210
Tyoe: Fie:
ElFiash (swh) Unkitlad-1 vl P
[ZIHTML (bl Unttiad-1 el o)
[JGIF Imege {.of) Untiled-1.of (5]
CIPEG Image (.4pg) Untiled-1.jog B
[Z1PNG Image (.png) Unkitled-1.png o] i
[CIwindowes Progsctor (exe)  Uniitiad-1.exs 2] |
[Imacrrosh Projector Untitled-1.hgx s ‘
L o o OO | .
fr
|
[ rbish ][ ex | [ coxad |
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3. Pilih tipe yang ingin Anda hasilkan pada pilihan kotak periksa Type, yaitu: .swf,
-html, .gif dan lain sebagainya.

Format HTML otomatis terpilih, karena file HTML dibutuhkan untuk
menampilkan Flash movie Anda ke dalam browser. Jika format yang dipilih
mempunyai sub perintah, maka akan ditampilkan tabulasi yang sejajar dengan
tabulasi HTML.

Pada bagian File, pilih salah satu perintah berikut:

* Gunakan nama file default yang sudah ada, jadi Anca tidak perlu mengetik nama
file baru.

e Hapus nama file default, kemudian masukkan r.ama file baru.

Anda dapat menentukan di mana Anda mempublikasikan file tersebut pada
lokasi yang derbeda. Sebagai contoh, jika Anda ingin menyimpan file SWF ke dalam
satu lokasi dan file HTML ke dalam lokasi yang lain). Dalam kotak teks, gunakan
backslash (\ ) untuk menyusun urutan penulisan directory, folder, dan file.

Sebagai contoh, D:\Folder\filenama.swf di mana D: adalah nama drive,
\Folder adalah nama folder, dan filename.swf adalah nama filenya.

Curren profie:|Defaut  vih.+l=elal
(Formats |Flash  HTmL )
] ]
!
!
Type: File:
[FlFiash (.swh) | ciiFashianmasit.snf ' F9) f
[FIHTM (o) [ntted-1hem  f8 "
[CIGIF 1mage (.gF) | Untitled-1.gf ) '
[ PEG Image (.4og) | Untiied-1.109 2
[1PNG Image (.prg) \unttedipo P8
[¥] Windows Projactor (.exe) | C:\FlashiAnimasil.exe B
[Machtosh Projecter | Untitled-1.hax P
[ QuickTime (.mov) | Untiiec-1,mov B

[ usoperaukmames |

[poih J [ ox ][ coel ]

Catatan:

e Untuk membuat sebuah file yang nberakhiran .exe, pilih pilihan Windows
Projector.

e Masukkan sebuah file baru, atau pilih Use Default Name agar setiap file
menggunakan nama file default.

¢ Tekan tombol Publish untuk menjalankan pilihan di atas dan klik OK untuk
menutup kotak dialog Publish Settings.
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PROYEK MEDIA PEMBELAJARAN INTERAKTIF

MEDIA PEMBELAJARAN INTERAKTIF

MATA PE LA]ARAN R.S

MEDIA PEMBELAJARAN INTERAKTIF .

MATA PEL IARAN RS

RENCANA AJAR

PERTEMUAN T ociiinnsiisimrannsmssnnnne
PERTEMUAN 2
PERTEMUAN 3 . ...coneeeccraninnrnns
PERTEMUAN 4
PERTEMUAN § ...
PERTEMUAN 6 ..o
PERTEMUAN T ...

PEATEMUAN B .....ooonvemninnnins

PERTEMUAN 9 ........oeoveenniee
PERTEMUAN 10

PERTEMUAN 11 ...
PERTEMUAN 12

PERTEMUAN 13 ...
PERTEMUAN 14 .....coivvinmimsrnnsisassiiin
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MEDIA PEMBELAJARAN INTERAKTIF

MATA PEI.AMRAN "x"

MEDIA PEMBELAJARAN INTERAKTIF

MATA PE I.AJARAN RS
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MEDIA PEMBELAJARAN INTERAKTIF

MATA PELAJARAN "&"

MEDIA PEMBELAJARAN INTERAKTIF

MATA PELAJARAN "X"

Sub Materil

Pada materi ini kita akan membahas tentang bla... bla... bla... Pada materi ini kita akan membahas
tentang bla... bla... bla...Pada materi ini kita akan membalas tentang bla... bla... bla...Pada materi ini
kita akan membahas tentang bla... bla... bla...Pada materi ini kita akan membahas tentang bla... bla...

bla_Pada materi ini kita akan membahas tentang bla.. bla... bla.__"ada materi ini kita akan membahas

tentang bla.. bla... bla...Pada materi ini kita akan membahas tentang bla_._ bla_. bla...

Pada materi ini kita akan membahas tentang bla... bla.. bla.. Pada materi ini kita akan membahas

tentang bla... bla... bla...Pada materi ini kita akan membihas tentang bla... bla... bla..Pada materi ini
kita akan membahas tentang bla_. bla_. bla_ Pada materi iri kita akan membahas tentang bla... bla..
bla...Pada materi ini kita akan membahas tentang b'a... bla... Sla...Pada materi ini kita akan membahas
fentang bla... bla... bla...

Pada materi ini kita akan membahas tentang bla... bla... | 'a...Pada materi ini kita akan membahas
tentang bla... bla... bla... Pada materi ini kita akan membuh.s tentang bla... bla... bla...Pada materi ini

kita akan membahas tentang bla___ bla_. bla._Pada materi in. kita akan membahas tentang bla... bla_..

P
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MEDIA PEMBELAJARAN INTERAKTIE ¢

MATA PELAJARAN "X"

MEDIA PEMBELAJARAN INTERAKTIF & g

MATA PELAJARAN "X

Sub Materi2

Padda matert ok kit akan membabas watang b, b, Bl Pada nateri ini kite akan menbahas tentang bla. bl
Bl Pada materi ini Kita akan membalas remang blac. blac, blo.Pada materd ing kita akan membahas tentang bis... bla...
blaMada materi ind i akan membahas wotang hla. blac. Bl Pada w o rerl ini kita akan membahas tentang bl bla.,
bla...Puda materi ini kina akan membahas tentana bla... bla.. bla. Pada m. eri ini kit akan membak. s entanye bla

Pada materi b kita akan membahas tentang bla. b, bla, Pada matesi o kita wkan menshas en

. hla bla

g bla. bl
bla..Padi materi ind kita akan membahas entang bla.. bla. bla..Pada materi ini kita akan membabas tentang bla... |

..
bla. Pada matent ini Kita akan mombahas tentang bla... bla... bla...Pada materi it kity akan membahas tentang bla. bla
bl ada imateri ini Kita akan membahas tenlang bla.., bla... bla...

Pada materi in

kit akan membahas tentang Bla.., bl bla.. ada materi ini kits akan membahas tentang bl bla.. bla
Paala maert ing k

ita akan membahas tentang bla.. bl Bl Pada maer Kita akan membahas tentang bla . bla.. bl Pada

et b K akan membahas wntang bl b, Bla, Pada matedd iai kita gkan nembakhas tentang bla.., bla...

maenr i Rita ahan mwmbabas lentang bl bla, bla Pada matert im kita skan membahas teatanyg bla... hiy
meateri ind kige akan membahac tentang bla., bla.. bla .

Pasky matert i kita akan membahas tentang bla, . bl bl Pada o atert i kita akan membabas tentang bla. bla..

Pla..Pada materi tni Mty akan membahas tentang bl bla.. Bla. Pada matert inl kita akan membahas tentang bla.., bla
bla s materi ing Kita ak;

v ephahas wnang blac, bla. bla o, o materd ini kits alan membahis tentang hla., bla o kla.

Mo bl !

Pasky matert ind kit akan membahas tentang bla

1 ma con ik kite akan mombahas tentang bla.., bla..

Plac Pl oanerd b Kt akan il

s et bla, Mae, bla Fada water i ini ... Irla

Halaman sebeluimnva 1 Halaman selanjutnya eﬂgnm%

b akian meibalias tenvang
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MEDIA PEMBELAJARAN INTERAKTIF

MATA PELAJARAN "X"

Coptoh-contol visualisgs

Mada maters ind hava akan memb s testang blhi. bla,. Bla.. Pada o

Pl Fank nraterd ind Rite akan mombaias wntang M., a1 el wateri ink Kt akan o

bla..."ada materi ind Kits akan mombahas wentang Ma.. bla. . e " s materi (e

Pt Pk nteri ing hita ahan ooy nnbanas testang Bl Blac Bl Pada maieri i hita

Pl Pada mters ind Rita akan membabas weateng bl bla., S

Bl Mada moteri ind Kita akan menbabas wentang hls

Padda matering kita akan membatias tertansg bla., bla. bls

salent v kit akan mvmbatias wentang

kita akan mombahas tentans
ST R

Pk onateri im Kite akan membahss tootave Bla., bla., Bla . Pada o ater il kit dhan memba
e maters im kite akan memb

e Bl ks materd ini kit akan mombabas tentany

vada maberi b kit akan atembabas watang dla. b, Bl Pada materi ot kita okan membabas wonta

wermhaiias Lo

Lan

i bla.. his.. bla

Pandit mvaters i kita akan mombalias entang bla L Bac, bl Pada marcis o bita akan imenibahas fenteng bla_ bla . bl Pads

Hataman sebelummya 2 Halaman seliniutnya

MEDIA PEMBELAJARAN INTERAKTIF

twst i kit aban moembabas tertans bla, bl blaPada et i ki, akan membaliae tentang bli,.. bla... bla...

MATA PELAJARAN "X"

mvaiivahas

aembahas tentans bla, bla, bla. I

k
omrtett o hita skan membabas tentang bla., bla., b

+ bl bla., bl

paker) I shan mombahas tents

bla.. big... bl

treninbos tentang bl Bl

Pk Pada maters ini kita akan n

tembah s entang bla.. b

Pada materi ini kita akan membabas wotang blo... bla... bl

Bl itk mateni ini ata shan memhafias e b, bl

bl inda materi Ini Kiva aken membahas ¢

bla. bla

bhic M materi ind kit akan mombahas tentang bla, bla., bla

YALUASI.

.

Pada materi im kita akan membahas tentang bla.. b

Marke it ] Tt Kt ahan membahas tentang bla.,, bla

Haloman sehehmava 1

Halaman sclaniotnva

tentany bla.. bla L slac . Pada materi i kita alan mem’ alias entans < blac, bl Pada ma

P kit akan

s Pada malers imt kit akan

Ao Pada maters b ket al

hia
. bilit..,

. bla,

Gﬂlmmg
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MEDIA PEMBELAJARAN INTERAKTIF

MATA PEI.AJARAN R4

Skor Akhir = [_S@

@D

é‘ KEMmBALE a
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MEDIA PEMBELAJARAN INTERAKTIF A
- _ MATA PELAJARAN "X"

¥ Soal Evaluasi

* Ketentuan Soal :

1. Soal dalam bentuk pilihan ganda
. Jumlah Soal ada 5

I~

3. Setiap soal benar skor 10

4. Setiap soal salah skor -5

ladaman selaninimns g @llhllﬂ @

MEDIA PEMBELAJARAN INTERAKTIF

MAYA PELAJARAN "X"
Soal ke

Bumi mengelilingi Matahari disebut .......................
a. Rotasi

b. Revolusi

:. ¢. Redudansi
gMATERI 4 3

d. Regenerasi

gklmuu 3
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